
ME141C 
INTRO TO MICROFLUIDICS 

 
INSTRUCTIONS FOR HOMEWORK #2 

DIFFUSION LIMITED SURFACE REACTIONS 
 

BACKGROUND 
 
This is an example of fluid flow in a micro channel coupled with a surface reaction taking 
place along the channel walls. A small concentration of a biological analyte is mixed with 
the fluid. The flow velocity is so small that the concentration of the analyte is transported 
to the reaction surface where it binds to an antibody ligand, mainly by diffusion through 
the fluid.  
 
Following figure shows a rectangular micro channel. An antibody ligand is immobilized 
along a small portion of the top wall, called the binding surface. A binding reaction 
between the ligand and the analyte takes place at this surface. The analyte is introduced in 
the fluid at the entrance of the channel. The flow profile at the entrance of the channel is 
parabolic due to no-slip at the walls.  
 
 
 
 
 
 
 
Your task is to analyze the reaction binding process between the analyte and the antibody 
ligand  as described in the homework. 
 
Governing Equations 
This is a multiphysics problem and involves the following types of physics. 
  
1. Convection and Diffusion 
The analyte is transported to the binding surface by diffusion. The following convective 
scalar equation predicts the suspended concentration C(x, y) of the analyte within the 
micro channel. 
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Where, ur  is the fluid velocity and D is the diffusivity of the analyte.  
 
Note: In this equation, isotropic diffusion was assumed. You will have to 
change to an anisotropic diffusion for your homework. 
 
2. Reaction Binding (Diffusion) 

Binding surface 

micro channel



Following the model given by Myszka et al. (1998), the rate of association is ( )on w Tk C R B− , 
where, onk  is the association rate constant, ( )TR B−  is the available antibody ligand 
concentration, and Cw(x) is the suspended concentration of analyte along the wall.  The 
rate of dissociation is offk B , where, offk  is the dissociation rate constant, and B is the 
concentration of bound analyte. The time rate of change of analyte bound to the 
immobilized antibody is equal to the rate of association minus the rate of dissociation 
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The rate of analyte binding to immobilized antibody, B t∂ ∂  must be balanced by the 
diffusive flux of antigen at the binding surface, 0y =  such that 
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Equations (10), (11) & (12) can be solved for the given immobilized antibody 
concentration RT  and the binding rates for different conditions can be found. 
 
SETTING UP THE MODEL IN FEMLAB 3.0 
 
Femlab 3.0 is the latest version of Femlab and it can be run either with MATLAB or as a 
stand alone program. We will do our modeling in the stand alone program. Let’s begin 
the modeling process. 
• Click on the Femlab 3.0 icon on your desktop if you are working on Windows 

platform. This command starts Femlab and opens the Model Navigator, which looks 
like the following. 

 



 
 
 
The Model Navigator is a multi-purpose dialog box which lets you add new geometries, 
and multiple physics modes in your model. 
• Press the Multiphysics tab on the Model Navigator. On the subsequent page, press 

Add Geometry tab. In the subsequent dialog box, use the following settings. 
Geometry name: channel 
Space Dimension: 2D 
 

 
 
Press OK. It will add a 2D geometry, ‘channel’ to your model. Now we will add 
multiple physics modes for this geometry. On the left hand side of the Model 
Navigator page, various available physics modes are shown.  
 



Add the following modes: 
Fluid Dynamics/Incompressible Navier Stokes 

• Now we will activate the Weak constraints for this physics mode. Press the 
Application Mode Properties tab. In the subsequent dialog box, choose Ideal in the 
Weak Constraint edit field. It is important to activate the Weak constraints as we are 
going to solve a coupled problem using coupling variables. 

 

 
• Now add the following mode to this 2D geometry 

Diffusion / Convection & Diffusion 
• Activate the weak constraints for this physics mode also. 
• Now we will add a new 1D geometry to the model, which will serve as the binding 

surface. Press the Add geometry button. Give the following settings for the new 
geometry. 
Geometry name: binding_surface 
Space Dimension: 1D 
 

 
 
• Press Ok to add the geometry. Select Diffusion physics mode from the Diffusion 

folder for this geometry. Change the Dependent variable name to B in the edit field 
on the left hand side and then press Add. In the following picture, one can note that 
the dependent variable name appears as B on the right hand side. 

 



 
 
• Activate the weak constraints for this physics mode also. 
• Now that we have finished adding geometries and physics modes, Press OK on the 

Model Navigator page. It will open up the FEMLAB window. On this window, you 
will see two tabbed pages, one for either geometry. 

 



 
 
 
ADDING CONSTANTS 
 
We will start by adding global constants such as properties of the fluid and diffusion 
constants etc. 
• Go to Options menu on the top of the Femlab window and choose Constants… 
• In the subsequent window, add the names and the values of the constants as shown in 

Table 1. 
 

 
Table 1: Constants 

Name of 
Constant 

Expression Units Description 

u_max 1e-3 m/s Centerline inlet 
velocity 

c0 1e-9 M or mol/L Inlet concentration of 
analyte 

kon 1e8 M-1s-1 Association rate 
constant 

koff .02 s-1 Dissociation rate 
constant 

Rt 1.67e-11 Mm Surface concentration 



of antibody ligand 
Diff 1e-11 m2/s Diffusivity of analyte 
hh .4e-4 m Channel height (for 

u_para) 
alpha 1 1 Size parameter 

 
Note: In my case, the channel height is 40 micron. You will have to change 
to what is given in the homework. 
 
DRAWING 2D GEOMETRY: channel 
 
Now we will draw the geometries. We will start with the 2D geometry, channel. 
• Go to the channel page. In order to draw, one has to be in draw mode. In our case, 

draw mode is selected by default. However, one can go to draw mode at anytime by 
pressing the Draw Mode button on the toolbar. 

 

 
 
The micro channel which we are going to model is of the order of few microns, while the 
area visible in the graphical interface is in the order of meters (SI units are default). We 
therefore have to change the size of the visible drawing area before we start drawing the 
geometry. 
• Go to Options menu and choose Axis/Grid properties. In the subsequent dialog box, 

set the following properties on the Axis page. 
x min: -5e-5 
x max: 30e-05 
y min: 5e-05 
y max: 10e-05 

 
Go to the Grid page. Uncheck the Auto radio button and set the following. 
x spacing: 1e-5 
y spacing: 1e-5 

• Press OK to apply these settings. It will modify the grid axes in your FEMLAB 
window. 

• Click on the Rectangle/Square button on the draw tool bar on the left in the Femlab 
window. Now click your left mouse button at the grid point (0, 0) and drag the mouse 
till the grid point (2.5e-4, 0.4e-4)—keeping the mouse button down—in order to draw 
a rectangle of 25e-05 by 4e-05 size. 

Note: In my case, the channel length is 250 micron. You might want to 
change it. 
 
• Now click the Point button on the draw tool bar to create points at the grid points: 

(0.9e-4, 0), (1.1e-4, 0). 
 



 
 
 
DRAWING 1D GEOMETRY: binding_surface 
 
Now we will draw the 1D geometry, called binding_surface. Go to the binding_surface 
page on the FEMLAB window. 
• Go to Options menu and choose Axis/Grid settings. Set the following on the Axis 

page of the dialog box. 
x min: -5e-5 
x max: 30e-05 
 
Set the following on the Grid page. 
x spacing: 1e-5 

• Now click on the Render Edge button on the draw tool bar and draw a line from the 
grid point 0.9e-4 to 1.1e-4. 

 

 
 
We have finished drawing the geometries. Now we will add Expressions and Coupling 
variables. 
 
 
 



ADDING EXPRESSIONS 
 
We will need expressions for some variables like inlet velocity etc. Expressions have to 
be defined for the two geometries separately. First we will define them for the 2D 
geometry, channel. Go to the channel page in the Femlab window.   
• Go to the Options menu on the top and choose Expressions-> Scalar Expressions. 
• Add the following expressions in the subsequent window.  
 
Name Expression 
u_para u_max*4*y/hh*(1-y/hh) 

 
u_para is the parabolic velocity profile at the entrance of the channel. 
• Now we will add boundary expressions. Go to the Options menu and choose 

Expressions-> Boundary Expressions. 
• In the subsequent window, select the binding reaction boundary (i.e. boundary no. 4) 

and add the following expression for this boundary. 
 

Name Expression 
react_bulk koff*c_surf-kon*c*(Rt-c_surf) 

 
react_bulk is the reaction rate at the binding surface which is located at the boundary 
no. 5. react_bulk will be used for specifying boundary condition in the Convection-
Diffusion mode. c_surf is a coupling variable and will be defined later. 

 
• Now we will add expressions for the 1D geometry. Go to the binding_surface page 

on the FEMLAB window. Go to Options menu and choose Expressions-> 
Subdomain Expressions. Select the subdomain 1 and add the following expression. 

 
Name Expression 

react_surf kon*c_bulk*(Rt-B)-koff*B 
 
react_surf is the rate of reaction for the Diffusion mode. c_bulk is a coupling variable and 
will be defined later. 
 
ADDING COUPLING VARIABLES 
 
We had noticed two coupling variables in the previous section. Coupling variables will be 
used for coupling the Convection-Diffusion mode and the binding surface Diffusion 
mode with each other. 
• Go to the channel page. Go to Options menu and choose Extrusion Coupling 

Variables->Boundary Variables. 
• In the subsequent dialog box, select the binding surface boundary (i.e. no. 4) and add 

the following expression. 
 

Name Expression 
c_bulk c 



 
• On the bottom of the dialog box, select the General Transformation radio button. 
 
• In the dialog box, go to the Destination page and select binding_surface and 

subdomain in the Geometry and Level menus respectively. Check the box in front 
of the subdomain 1. Press OK. 

 

 
 
• Now we will add the second coupling variable in the 1D geometry. Go to the 

binding_surface page in the Femlab window. Go to Options menu and choose 
Extrusion Coupling Variables->Subdomain Variables. 

• On the Source page of the dialog box, select the subdomain 1 and add the following 
expression. 

 
Name Expression 
c_surf B 

 
• On the bottom of the dialog box, select the General Transformation radio button. 
• In the dialog box, go to the Destination page and select channel and boundary in the 

Geometry and Level menus respectively. Check the box in front of the binding 
surface boundary (i.e. no. 4). Press OK. 

 
 

 
• Now we will add two Integration Coupling Variables for the same 1D geometry. 

These variables will be used for integrating the bound concentration B on the binding 
surface and for calculating the length of the binding surface. Go to binding_surface 



geometry page. Go to Options menu and choose integration Coupling Variables-
>Subdomain Variables. Add the following 

 
Name Expression Integration 

Order 
Global 

Destination 
B_tot B 4 Keep the box 

checked 
x_length 1 4 Keep the box 

checked 
 
B_tot is the integral of B on the binding surface, x_length is the length of the binding 
surface. The average bound concentration is the ratio of B_tot to x_length. 

 
 
SUBDOMAIN SETTINGS 
 

Now we will start setting the coefficients and the initial conditions for the partial 
differential equations. This is done by defining subdomain settings for different physics 
modes.  
channel: Convection and Diffusion mode 
• On the Coefficients page, select the subdomain no. 1 and set the following. 

D isotropic = Diff (You know what you have to do here) 
Reaction rate = 0 
x-velocity = u_para 
y-velocity = 0 

 
binding_surface: Diffusion Mode 
• On the Coefficients page, select the subdomain no. 1 and set the following. 

Time scaling coefficient = 1 
Diffusion coefficient = 0 
Reaction rate = react_surf 



 
 
BOUNDARY SETTINGS 
 
• Now that we have defined the subdomain settings, we will proceed to define 

boundary conditions for all the governing partial differential equations.  
 
Convection and Diffusion 
• Go to Multiphysics menu and select the channel: Convection and Diffusion. Go to 

Physics menu and select Boundary settings.  
• The default boundary condition for this mode is Insulation/Symmetry, which is 

applicable for all the boundaries except inlet, binding surface and outlet boundaries. 
• Select inlet boundary from the list. Select Concentration from the Boundary 

condition menu. Write c0 in the Concentration edit field. This means that a constant 
concentration of the analyte is introduced at the inlet. 

• Now select outlet boundary. Select Convective flux from the Boundary condition 
menu. This means that convection >> diffusion at the outlet. 

• Now select binding surface boundary no. 4. Select Flux from the Boundary 
condition menu. Write react_bulk in the Inward Flux edit field. This means that the 
analyte concentration is lost at this boundary due to binding reaction with the 
antibody. This boundary is coupled with the 1D geometry, binding_surface. 

• Press OK. 
 
Diffusion mode 
No changes have to be made for this mode. 
 
 
MESH GENERATION 
 
Meshing of 2D geometry: channel 
Now that we have defined all the constants, variables, subdomains settings and boundary 
conditions, we will move on to mesh generation for our geometries and then solve the 
governing equations of various physics modes. We will start by meshing 2D geometry, 
channel.  
• Go to Mesh menu on the top of your Femlab window and select Initialize mesh. It 

will create a coarse mesh for the channel geometry. 
• Now we will refine the mesh near the binding surface . Go to Mesh menu and choose 

Mesh parameters. On the dialog box, go to Boundary page. Select the binding 
surface boundary (no. 4) from the list and write 0.2e-6 in the maximum element size 
field. 

•  Press the Remesh button on the bottom of the dialog box. Remember that pressing 
OK will not remesh the geometry. After pressing Remesh, press OK to exit. 

• Now we will mesh the 1D geometry, binding_surface. Go to the binding_surface 
page on the Femlab window. Go to the Mesh menu and select Initialize mesh. No 
refinement is necessary for this geometry. 

 



SOLVE THE PROBLEM 
 
Go to Solve menu. Choose Solver Parameters. Choose the Time Dependent solver. 
Write 0:0.05:2 in the Times edit field. 
 
Go to Solve menu. Choose Solve Problem. 
 
POST PROCESSING 
You can make various types of plots and animations by going to Postprocessing-> Plot 
parameters and Postprocessing-> Cross section plot parameters. You have to do 
postprocessing for the two geometries separately. So go  2D geometry page and see what 
kind of plots you can make. Then go to the 1D geometry page and see what kind of plots 
you can make for this geometry. I will elaborate on this in the instruction session on 
Tuesday. 
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